Liferay - Web Content Management Basics
Use Firefox 3 for best results. Do not use older Firefox versions or Internet Explorer 6 as the Liferay
system will not work correctly. NOTE: There is no spell checker on the Web site. The Google Toolbar addin for Firefox or Internet Explorer provides a spell checker that you can use while creating your content in
the Web portal system. For installation instructions and online help go to http://toolbar.google.com/.

Log into Your Web site
1) Open browser and go to: http://liferaydemo.unl.edu/c/portal/login
2) In the Already Registered tab under the “regular account” section
on the left side of the “Sign In” dialog box, login with your
username and password. Click on the Sign In button immediately
below the Password text box. NOTE: Please see page 12 for
information on changing your password.
3) Once logged in you will see the generic “Signed In” page. To go to
your site’s homepage…
a) Hover the mouse-pointer arrow over the
Welcome menu bar on the upper right side
of your screen to open the drop-down menu.
b) Move the mouse-pointer arrow over the My
Places option to open the pop-out submenu.
c) Click on the site name and then click on
Public Pages option to go to the editing
mode of your Web site.

Be sure to preview your Web pages in both Internet Explorer and Firefox browsers. Each can have
unique display problems if there is “bad coding” on the page or if an image, table, or link “word” is too long.
The edit view is 99% correct, but it is always best to preview your page in the “public view.” Before the
Liferay version of your site goes live, the public view Web address is
http://liferaydemo.unl.edu/web/xyz
(replace xyz with the name of your site)

When finished editing your Web site, go to the Welcome menu and click on Sign Out.
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Add a New Page with the Add/Modify Page applet
There are two ways to add new pages. We will first use the custom Add/Modify Page applet created by CIT.
This applet allows you to create a page, select the layout style of the page, and put empty content holder
places on the page while using one dialog box.
1) Hover the mouse-pointer arrow
over the Welcome menu to open
the drop-down menu.
2) Click on the Add / Modify Page
option to open the dialog box.
3) Complete the 4 Required fields.
a) Create Parent page or Child
page - New Parent page is at
the same level as the Home
page. A Child page is below a
parent page, like folders on
your computer. HINT: You
may create a child page under a
child page. Each new sub-level
(folder) of page will be shown with a dash. No dash = top level (Parent). One
dash = child page. Two dashes = 2nd level child page. And so on.
b) FileName - Use a unique name for each page as this is part of the Web address.
Must contain only letters and numbers, no spaces.
c) Page Title - Enter succinct and descriptive title that is used by Web page visitors and search engines.
It shows in the browser title (blue) bar and is the first item used for ranking by search engines.
d) Navigation Title - Enter succinct title that will show in the UNL Navigation Breadcrumb trail. You
will use this title to find this page during the editing process. This title may contain multiple words.
4) You may change the Page Type by selecting 1 of the 5 options available with the UNL template.
5) You may change the Content Area Layout Type by selecting one of the layout options. NOTE: as of
November 1 only 3 options are available. More options will be added to provide the full array of options
within the 4-column content area.
6) Navigation Title Display Status - The default setting is Hide which means the Navigation Title will
NOT be visible in a menu. Select “Display” to make the Navigation Title visible in the top
Navigation menu or a left navigation menu (menu items need to be short, 2 or 3 words max).
7) Meta Tags - OPTIONAL - The Meta
Description option is often used by
search engines as the description
shown for your site on the results
page. Write an effective meta
description, unique for each page. It may help with “click-through” rate, but most likely will not
help page ranking.
8) Click on the Add New button to add this page.
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9) You will receive a confirmation message box that includes instructions on adding content to this
page. Click on the red X to close the box.
If the Navigation Title is not visible in a menu, go to this page by...
1) Hovering the mouse-pointer arrow over the Welcome menu to open the drop-down menu.
2) Click on the Sitemap menu option to open the window displaying all page Navigation Titles.
3) Click on the Title of the page you want to edit and the page displayed will change to that page.

Add Content to the Page
All user-created content (text, links to other Web
pages, links to downloadable documents, images)
exists in “Journal Articles.” Content is entered in a
Journal Content holder. Your content will replace
the “Select an…” text line. One page may contain multiple articles.
1) Click on the Add Article

button to open the Journal Article dialog box.

2) Enter a unique Navigation Title for
this article. NOT seen by public
viewers. You may use this title to
search for the article to use this
content on another page or to delete
the article at a future date.
3) ADD your content (text, images, and
links) into the editor content box.
4) APPROVE content by clicking on
the Save and Approve button. NOTE:
Use Save and Continue button to save
content on server and continue to edit
the article. Use the Save button to
save the article without making it
viewable by the public.
5) All other fields are optional and
seldom changed.
Update the article
After the first save, an Edit Article button
will be added at the bottom of the Journal Content holder
(below the text). Click on the Edit Article button to return to the editor. Click on the Save button to save
changes for public view. NOTE: Once an article is “approved” the Save and Approve button disappears.
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Add text content
Type your text directly into the editor text box. It is recommended that you complete all formatting changes
(bulleted list, header, etc.) before adding links.
WARNING about pasting text from another source: Whether you paste text from Microsoft
Word, WordPerfect, Lotus Notes email, another Web page, or other source, always use the
or you will have problems with the display of your content.
Paste as Plain Text option
You will use the features in this editor to format your text.
Internet Explorer users: You will have 1 additional
click to make sure you are using the Paste as Plain Text
feature. When you click on the button in the editor, you
will get this dialog box. Make sure to click on the Don't
allow button and then you will see the regular Paste as
Plain Text dialog box and can continue.
Copying from Dreamweaver: It will work best to copy from Dreamweaver’s Code view (all
codes inside the <body> tags, not including the <body> tags) into this editor’s Source
view. If you need to put your content inside a Table, it is highly recommended that you use
Dreamweaver because the Table feature in this editor does not work well.

Keyboard hints




Enter key - creates a new paragraph with a blank line between paragraphs
Shift+Enter - moves cursor to new line of entry, no blank line
Space bar - there is no Tab function, use the space bar to indent a line of text

Google spell check
To spell check your text, click on the Spell Check button
in the Google toolbar. The
editor content box background will change to blue and misspelled words will be highlighted in
red (see image at right). Click on the word and then select the correct option from the pop-up
menu. To stop spell checking, click on the “stop” button.

REMINDER:
You are editing a LIVE Web site.
All content on a Web page can be seen
by anyone finding this site.
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Text Format options
Many of the features (buttons) are the same as in your word processor, for example, Bold, Indent, Bullet List,
Center Justify, etc. This guide will only explain those features unique to creating a Web page.
Use the Format feature to properly code headings and subheadings. This helps the reader scan your page
and helps with search engine optimization.
Heading 1 is the largest heading and should
be the first one used on the page. Heading 2
is next in size and so on. The screen capture
image on the right shows the relative sizing
and text spacing produced by the UNL
template style sheet controls.

The Style feature offers custom styles from the UNL Style Sheet and should be used
sparingly to highlight a particular piece of content on the page. NOTE: As of 11/2/09
the Style menu only contains styles from the 2006 UNL Template. This feature will
only work on ONE paragraph of text. If you want to have multiple, separate lines
within the colored area, you must use the Shift+Enter key. The options shown at right
are the best ones to use as these provide a background color for text.
To use the Style option follow these steps.
1. Type the text and then select it.
2. In the Format drop-down menu, select Normal (DIV).
3. In the Style drop-down menu, select the option you want to use.
Since the UNL default style uses a dark gray text color, you can use the Text Color
feature to use black to highlight selected text. The screen capture image at left shows
the black color selected. Use other colors VERY SPARINGLY as most will not work
well with the UNL style settings.
Use the Blockquote

feature to create double indented paragraph(s).

Use the Insert Special Character
button to add copyright symbol, special bullet characters,
foreign language characters, and other non-keyboard characters. In the dialog box, click on the desired
character. The box will close and the character is inserted at the cursor position.
Use the Horizontal Line feature to add a simple line between different pieces of content.
Use it sparingly.
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Very rarely should you use the Font or Size feature. The default UNL template style settings create a
coordinated look.
Verdana is the default font of the UNL style sheet. This is a
font created for on-screen reading. The only other font
recommended for very limited use is Comic Sans MS. You
can use this in headings on pages meant for youth or for a
more informal feel.
If you select a different size, only use Smaller or Larger as
each will look correct with the UNL template settings.

Link to a Web page on another Web site
Link text is important for accessibility issues and search engine optimization.
Accessibility:
Links should make sense out of context. Phrases such as “click here,” “more,” “click for
details,” and so on are almost completely meaningless when read out of context. (Read
WebAIM “Introduction to Links and Hypertext” article for more information,
http://www.webaim.org/techniques/hypertext/.)
Search Engine Optimization:
One of the most important aspects of SEO-friendly site design is the structure of your navigation
and internal links.... Include key search terms in your link text and focus on making your site
easy to navigate for both users and search engines. (Read Search Engine Watch “SEO Site
Structure 101, Part 2” article for more information, http://searchenginewatch.com/3632212.)
1) Select the text the reader will click on.
2) Click the Insert/Edit Link button (see image at right) to open the Link dialog
box.
3) Enter the URL (Web address) in the URL text box.
a) HINT: To avoid a spelling error, open the page you want to
link to in a separate browser window and copy the Web
address. When you paste in a complete Web address, the http://
portion of the address will automatically be eliminated by the
editor Link function.
4) Click on the OK button to return to the editor content box.
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Link to a new page within your site
1) Select the text the reader will click on.
2) Click the Insert/Edit Link button to open the Link dialog box.
3) Click on the Browse Server button (see image previous page) to open the Resources dialog box.
a) In the Resource Type menu (upper left) select Page.
b) Click on your Web site name in the right pane, then the
dialog box will show the site structure of folders and files.
4) Go to the subfolder that contains the page to link to.
5) Click on the page name to create the link to the page. Click on
the paper document icon
NOT the folder icon.
6) In the Link dialog box the “Protocol” setting will now show
<other>, click on the OK button to return to the editor content box.

Link to a downloadable document file
PDF is the Web standard file format for sharing print-oriented documents. PDF is not a
replacement for a regular Web (HTML) page. When sharing PowerPoint slide shows or Word
documents with others who have no need to edit a file use the PDF version. Advantages are that
PDF files are smaller than the native file and there is no problem with people using different
versions of MS Office programs.
When you link to the PDF file, be sure to tell the reader it is a PDF file and give the file size
(example: PDF 556 KB, 24 pages). Also, provide a link on the page for users to go to the Adobe
site to download the free Adobe Reader. Put the following text (or similar text) with link at the
bottom of your content.
* Download free Adobe PDF Reader [ link to http://get.adobe.com/reader/ ]
Excel files (xls) can be used when providing an “executable application” for public download.
All downloadable documents linked to on pages within the Liferay system are uploaded to the server and
reside in the Document Library. You can upload any file at the time of creating or editing an article.
NOTE: The maximum file size allowed is 3000k (3MB).
1) Select the text the reader will click on to open the file.
2) Click on the Insert/Edit Link button to open the Link dialog box.
3) Click on the Browse Server button (see image previous page) to
open the Resources dialog box. Document is the default
Resource Type.
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4) Click on the site name in the right pane to go to the documents folder(s).
a) You cannot add files to the root folder, so on the first time in this dialog box, you will need to click
on the Create New Folder button at the
bottom of the box.
b) Type the name of the subfolder in the
subsequent dialog box and click on the OK button. Per Web standards, the folder name should be one
word.
5) Click on the new folder name to open it and then click on the Browse button at the bottom of the dialog
box. Find your document file on your local computer and “Open” it so that the file name appears in the
“Upload...” text box.
6) Click on the Upload button to add the file to the folder on the Liferay server.
7) Click on the file name of the document to link to it and return to the Link dialog box. You will see the
unique URL for this file on the Liferay server. Do NOT change this address.
8) Click on the OK button to return to the editor content box.

HINT: Test all links with the Preview feature.

Insert an image
Images MUST be properly sized (resized/cropped/adjusted in an image editing application)
before being uploaded onto the Liferay server and used on a Web page.
CIT supports two image editing applications: Adobe Photoshop & IrfanView. Step-by-step
instruction sheets are available on the CIT Tips, Tricks, & Techniques site.
Adobe Photoshop - http://cit.information.unl.edu/tips/photoshopinstructions.htm
IrfanView - http://cit.information.unl.edu/tips/irfanview.htm
All images inserted on a page within the Liferay system are uploaded to the server and reside in the Image
Gallery. You can upload an image file at the time of creating or editing an article. NOTE: Image file size can
be no larger than 300KB.
1) Click in the content area where you want the image to reside, then click on the Insert/Edit Image
button
to open the Image Properties dialog box (see sample image in Step 7).
2) Click on the Browse Server button to open the Image Resource dialog box.
3) Click on the Web site name in the right pane to go to the images folder(s).
a) You cannot add files to the root
folder, so on the first time in this
dialog box, you will need to click
on the Create New Folder button.
b) Type the name of the subfolder in the subsequent dialog box and click on the OK button. Per Web
standards, the folder name should be one word.
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4) Click on the folder name to open it and then click on the Browse button at the bottom of the dialog box.
Find your image file on your local computer and “Open” it so that the file name appears in the
“Upload...” text box.
5) Click on the Upload button to add the image to the folder on the
Liferay server.
6) Click on the file name of the image to return to the Image
Properties dialog box and a preview of your image. You will see
the unique URL for this file on the Liferay server. Do NOT
change this address.
7) Change 3 property settings for correct display of your
image.
a) Alternative Text: Enter a succinct description of
the image in the field. This is a Required field and
MUST be completed to be compliant with UNL
standards and 508 Compliance regulations for
visually impaired readers.
b) Align: Select Left or Right to have text wrap like in
a printed document. If you place an image that is to
have no text wrapped around it, use the Top align
setting. Other options are rarely used.
c) Advanced - Style: To add white space around the
image, click on the Advanced tab. Enter this text in
the Style text box at the bottom of the dialog box:
margin: 2px 5px ;
8) Click on the OK button to add the image to the article and return to the editor content box.

The next sections will deal with making changes on the page.
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Add Journal Content holder to a page
When you need to add separate content and do not have an empty content holder, you must first add the
content holder.
1) Hover the mouse-pointer arrow over the
Welcome menu to open the drop-down menu.
2) Move the mouse-pointer arrow over the Content
Controls option to open the pop-out submenu
(see image at left).
3) Click on Add Page Content to open the Add Application dialog box.
4) Click on Authoring.
5) Click on the Add link for Journal Content to add an article holder to the
page. HINT: You may add more than one at a time. Empty holders do
NOT create blank space on the page.
6) Click on red X to close Add Application dialog box.
7) By default, the new Journal Content holder will be placed at the top of the page.
8) You can move the Journal Content holder to another location on the page.
a) Move the mouse-pointer arrow over the Journal Content title until it turns into 4-headed arrow. Click
and hold the left mouse button.
b) Drag the outlined box to the location you want it in. When you see green arrows pointing to the
correct location, release the mouse button to place the Journal Content holder in this position (see
sample below).

Remove Content from a Page with the Close option
To remove a specific piece of content from a page click on the
Close option next to the Content holder title.
This only removes the content from the reader’s view. The
content still exists within the Liferay content management system
in your website’s Journal Article Library. You can edit the article,
use the article on another page, or delete the article from the Web server. Please see the Liferay - Use the
“Libraries” to Manage Content instruction sheet.
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Change the Page Title using the Add/Modify Page feature
The Page Title is the first piece of content used by search engines to determine ranking. You need to make it
very descriptive and unique for each page.
1) Open the Welcome menu and click on the Add / Modify Page option.
2) At the bottom of the dialog box, click on the Select drop-down arrow and select
the Title of the page you want to edit (see image at right).
3) Click on the Go button to go to Edit form for that page (see image below).
4) The Page Title text box will show the current title text. Update the text.
5) Click on the Save button. Please note: this change has been made but will not show immediately.
6) You will receive a confirmation message in the dialog box and can now close the dialog box by clicking
on the red X in the upper right corner.

Delete a Page using the Add/Modify Page feature
REMEMBER: You are editing a LIVE Web site.
When you want to delete a page, you must first delete the link to that page. This will prevent the reader from
clicking on a “dead link” that returns an error message. Also, when you delete a page, the page filename is
still in the system so you cannot use that filename again.
1) At the bottom of the Add / Modify Page dialog box, click on the Select drop-down arrow and select the
Title of the page you want to delete (see image above).
2) Click on the Go button to go to Edit form for that page.
3) Confirm that this is the page you
want to delete and then click on the
Delete button (see image at right).
a) WARNING: Deleting a page
that has child pages under it will
also delete all child pages under
this page! Content in articles
will not be lost as all Journal
Articles are still accessible in
the Journal Article Library.
4) You will receive a warning
message; click OK to complete
deleting the page.
5) You will receive a confirmation
message in the dialog box and can
now close the dialog box by clicking on the red X in the upper right corner.
All content still exists within your website’s Journal Article Library. Please see the Liferay - Use the
“Libraries” to Manage Content instruction sheet for information on working within the Library.
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Modify the Layout of Content on the Page
You can change the arrangement of the content on
the page with the Modify Page Layout feature.
1) Go to Welcome - Content Controls menu.
2) Click on the Modify Page Layout option to open
the Layout dialog box.
3) Click on the radio button of the name of the
layout you want to use.
4) Click on the Save button to return to the page.
5) You will most likely need to move the content
pieces into the correct locations. See instructions
in previous section.

Changing Your Password
1) Hover the mouse-pointer arrow over the Welcome menu to open the dropdown menu. Click on the My Account menu option to open this dialog box.
2) Click on the Password tab to open that section.
3) Enter your new password in the 2 text boxes displayed.
4) Click on the Save button above the tabs to save your change. You will see the
“success” message shown below.

To use your new password, Sign Out (from the Welcome menu) and log back in using the new password.
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